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Copyright

Microsoft, Windows 98-SE/ME, Windows NT, Windows 2000/XP, Vista, Windows 7 and Excel are 
registered trademarks of Microsoft Corporation.

This manual and the software are copyrighted with all rights reserved. Under the copyright 
laws, neither the documentation nor the software may be copied, photocopied, translated, 
or reproduced in any way without the written consent of Eltek Ltd.

Information in this manual is given to the user for guidance only. Eltek does not accept any 
liability for damage or loss incurred directly or indirectly as a result of the use of this software 
or documentation.

Copyright © 1998-2014 Eltek Ltd.
All rights reserved.

Darca software is for a single user. The conditions of the licence can be found in the 
software by clicking  >  >  . For multiple user licences please 
contact Eltek Ltd or your local distributor.

Help About View Licence

TM1020GB 15/07/14
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Due to our policy of continuous improvement, we reserve the right to modify this program 
at any time. 

Overseas customers should direct any enquiries to their local distributor.

Eltek Ltd
35 Barton Road
Haslingfield
Cambridge
CB23 1LL Telephone +44 (0)1223 872111
UK Fax +44 (0)1223 872521

Website: http://www.eltekdataloggers.co.uk

We would welcome any comments on this product by email to
darca@eltekdataloggers.co.uk

Note:
“Squirrel” is the generic name for all Eltek wired (450 / 850 and 1000 series) and RX250AL / 
RX250ALD GenII wireless data receiver loggers.

“Modem” refers to landline and GSM modems. For a landline to GSM modem connection, a 
GSM circuit switched data number is required. For a GSM to GSM connection a voice 
number only is required. See the document ‘GSMPC modem kit’ ( for more 
information. This can be found on the Eltek website at 
www.eltekdataloggers.co.uk/support.html.

TU1017) 
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Introduction
The Darca installation utility contains the suite of programs below:

is the program for setting up, downloading, and translating data from Eltek Squirrels. 
Features include: 

Multiple channels can be edited simultaneously
Squirrels can be contacted directly or via modem
Phone list makes accessing a number of Squirrels straightforward
Set-ups can be saved to disk and uploaded to Squirrels
Wired Squirrel settings can be changed off-line and uploaded later
Channels can be renamed for easy identification when metering
Alarms can be set up and metered
Data can be graphed using powerful graphing tools
GenII transmitters can be configured
Phone number list for GSM text messaging on alarm 

is the utility for automating contact with Squirrels.

is the program for configuring the GenII RP250GD repeater. 

Darca 

Shed 

Rep Conf 
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Online Help

System Requirements

The majority of the documentation for Darca is kept in the integrated Help system. For more 
information on any item within the program, click Help, or press the F1 key. The Help file 
also contains a detailed tutorial. 
Note: The Windows Help system is not included with Windows Vista or Windows 7 by 
default. Darca Plus uses this form of help. If Windows Help is not installed on your PC, see 
the instructions in the FAQ section of the Eltek website for information on how to 
download it:
http://www.eltekdataloggers.co.uk/support.html

System requirements are:
PC running Windows 2000, XP, Vista or Windows 7
CD ROM disk drive (for installation)
One unused serial port (or USB port with serial to USB adaptor)
LC68 cable (Logger to PC serial lead)
LC-TX3 cable (for configuring transmitters via Darca on a GenII system)

"

"

"

"

"

" A Windows compatible modem if you would like to dial up Squirrels remotely
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Installation

Launching the software

Note about folders in Darca

Insert the Darca CD in your CDROM drive and the installation program should automatically 
run. If it does not:

Windows 2000 / Vista /XP: From the , choose  
WIndows 7: Type  in the search bar and click  when it appears
Type  (where x is CDROM drive) and press ‘Enter’

Follow the on-screen instructions to install the software.

To run , select the Darca icon from the Eltek entry in the .
To launch  automatically every time Windows is started, create a shortcut to Shed 
in the  group.
To run , select  from the Eltek entry in the 

. For instructions on using Rep Conf, see the document TU1007, 
available in the  >  section of the Eltek website.

Darca creates several sub-folders within the Darca data area folder:

’Darca\Setup’, which is used for storing Squirrel setup files (.sqi extension)
’Darca\Squirrels’, which keeps a database of information about every Squirrel 
contacted in order to speed up contact time 

These sub-folders may be moved to a different location provided that the relevant details are 
updated in the tab of the  > window. 

"

"

"

"

"

"

"

"

"

Start Menu un...
Run Run

x:\setup

Darca Programs Menu
Shed

StartUp
Rep Conf Repeater Configuration

Programs Menu
Support Literature

Folders Settings Preferences 

R

(.cfg extension)
’Data’ which is used for storing Squirrel data files (.dat extension)
’Export’, which is used for storing exported data to be analysed with a spreadsheet
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Overview
Darca stands for ownloading nd emote ontrol pplication. 
It is designed to communicate with Squirrel data loggers. It performs four main functions:

Downloading Squirrel data
xporting it into 3rd party spreadsheets / analysis packages

Remote configuration of Squirrel settings and channel setup
GenII Squirrel and Transmitter setup

These may be achieved either through a direct RS232 serial connection, via an RS232 to USB 
converter,  via a modem (excluding GenII transmitter setup) or via ethernet using a Moxa 
serial to ethernet converter.

D A R C A

"

"

"

"

Graphing Squirrel data or e
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The Main Window
The Main Window is the first window that appears when Darca is launched. The top of the 
Main Window carries a menu bar through which all of the program’s functions can be 
accessed. The Status Bar at the bottom displays information about the status of 
communication between Darca and the Squirrel. Between the Menu Bar and the Status Bar 
is the Control Panel. The buttons that appear depend upon the current connection status.
When Darca is first started, the Control Panel shows the buttons listed below:

Export Data Converts a Squirrel Data file (.DAT) into a text file suitable for 
importing into spreadsheet programs.

View Graph Displays a graph of a DAT file.

Preferences Makes changes to the way Darca operates

Contact Wizard Goes through the steps of establishing contact with the 
Squirrel, allowing configuration of the way the Squirrel will be 
contacted.
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The Contact Wizard
The Contact Wizard Step 1 provides four options for Darca to contact the Squirrel.

Use direct connection (LC68 lead) or modem and follow the steps to get to the 
Contact window. 

Use direct connection (LC68 lead) or modem. A connection session can be 
created enabling a quick setup routine for frequent connection to the Squirrel. 

Creates logger setup files and is for when no logger is 
connected. It takes you directly to a cut down Contact Window. Setups can be downloaded 
to the logger or loggers of the when needed. 

 Once a GenII Squirrel has been contacted this option directs 
you to four Squirrel / Transmitter setup options.  See Page 23 for details.

If this is the first time you have contacted the Squirrel, there will be no Squirrel setup file (.sqi 
file) for this Squirrel stored on your computer. In this instance, a dialog will appear informing 
you that the stored settings do not match those in the Squirrel and offering you three 
options from which to choose. Choosing the first option allows you to create an sqi file for 
your Squirrel. An sqi file stores all Squirrel settings and transmitter configuration and can be 
sent back to the Squirrel in the future if required.
To choose whether this dialog appears on contact, use the checkbox at the bottom of the 

 >  window.

Manual: 

Automated: 

Offline: wired Squirrels only 

GenII / Transmitter Setup:

Note about Squirrel setup files (sqi files)

Preferences Automation

Note: the logger display must be blank before Darca can contact 
the logger.

same type 
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Contact Window
The Contact Window appears once a Squirrel has been contacted. Settings in the Squirrel 
can be changed online, logging can be started and stopped, runs can be downloaded from 
the Squirrel and the Squirrel’s memory can be cleared. The Meter Channels window can also 
be opened. Various combinations of the following buttons can appear in the Contact 
window.

 

 

 

 

Download Runs: Displays the Download dialog box 

Meter Channels: Displays the current input of all selected channels in bar or 
diagrammatic form

Squirrel Settings: Configures various aspects of the Squirrel using Darca 

Channel Setup: Configures the 
channels on the Squirrel 

Squirrel / Transmitter Setup: 
Restores transmitter setup if closed 
(See p.23)

Start/Stop logging

Clear memory
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The Status Bar

Menus

The Status Bar at the bottom of the window contains four areas that indicate the status of 
the connection between the Squirrel and Darca:

The left-hand box shows whether or not a connection has been made.
The next box shows the current state of communications through the selected serial 
port.
The third box is the state of the Squirrel. This can be asleep or awake. Darca must 
wake the Squirrel before communications can start. 
The right hand box shows ‘Retries’ followed by two numbers. The first number is the 
number of times Darca has failed to wake up the Squirrel. The second number is the 
number of times Darca has not had a response from a transmitted command.

The menus provide access to all of the functions and options of Darca. Some of the menu 
items are just alternative ways of getting to the same functions that the buttons provide.

"

"

"

"
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File Menu 
The File Menu contains the options for all the file-based operations in Darca. It also contains 
an option to close the program. 

ot applicable to GenII Squirrels)
This option can be used when no Squirrel is connected to Darca. In this context, Darca will 
open the file in offline mode. This allows the settings within the file to be changed without 
the need to connect a Squirrel. See ‘offline contact’ in the online help for more information. 

ot applicable to GenII Squirrels)
This option is available when Darca is connected to a Squirrel. This allows Darca Squirrel 
Setup files (*.dss) for wired Squirrels to be loaded from disk. If this option is selected when 
Darca is in contact with a Squirrel, then the selected Squirrel setup is sent to the Squirrel. 
Note that the setup file can only be sent to the same model of Squirrel for which it was 
created.

ot applicable to GenII Squirrels)
Closes an open Squirrel Setup File. If the file has not been saved, a prompt appears to 
confirm the action.

Enables the viewing of exported Squirrel data in text or tabular form.

Edit Wired Setup Offline

Send Wired Squirrel Setup 

Close Wired Setup

View Export

 (n

(n

 (n
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View Graph

Save Wired Setup

Save Wired Setup As

Download

Displays a graph of a Squirrel data file together with summary information.

ot applicable to GenII Squirrels)
Stores the current Squirrel setup to disk. If the current setup has not yet been named, the 
Save Setup As dialog appears.

ot applicable to GenII Squirrels)
Stores the current Squirrel setup to disk after prompting for a filename. 

Only available during contact with a Squirrel, this option initiates the transfer of recorded 
data from the Squirrel to the computer.

 (n

 (n
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Export

Memory Card Utils

Exit

Once data has been downloaded from the Squirrel, it may need to be processed into a form 
that can be read by a spreadsheet application. Choosing this option brings up a dialog from 
which the data file (.dat) can be selected. Darca then processes the data in accordance with 
the current Export Settings and writes it into a new Export file. 

In  > , Darca can be configured to automatically export the data 
immediately after a download. With this option selected, the exported file will be 
automatically opened in Excel if the ‘Export Data’ button on the main window was 
used to perform the export.
The exported data is divided into a number of files depending on the  
setting in  > . Set this to to create a single file.

Some special Squirrels use PC Memory (SRAM) Cards to store data. These utilities enable 
preparation and management of the card and its data.

Closes the program.

Notes 
Settings Preferences

Rows per file
Preferences Export 0 

"

"
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Contact Menu
The Contact Menu contains the available options for contacting Squirrels.

Initiates contact with a Squirrel connected to the computer’s serial port, either physically 
(using an LC-68 lead) or via ethernet (using a Moxa ). The correct serial port must 
be selected and a compatible baud rate must first be chosen from the  
dialog (accessed from the  menu or from the  button 
- see p.17). 

For a physical connection: Eltek Squirrels with serial numbers greater than 6000 operate at 
38,400 baud.

For an ethernet connection: When using a Moxa , ensure the baud rate is set to a 
maximum of 19200 and that the COM port matches the setting in the NPort settings utility.

Jumps to the  and selects the Modem option. A phone number 
can be entered. Once done, the  button starts the modem dialling and initiates 
the contact. It is important to configure the Squirrel modem correctly; see Darca’s integrated 
help for more information.

To minimise connection time by executing a predetermined set of actions on a Squirrel, 
Darca can be configured to carry out contacts automatically. The tasks can be specified in 
the  window (accessed from the  menu).

Direct

Modem

Automated

DE-5110

DE-5110

Communications
Settings Configure Communications

Contact Wizard Step 2
Next >>

Preferences Settings
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Contact Wizard

Disconnect

See  for more information.

Stops all communication between Darca and the Squirrel and returns Darca to the Main 
Window. In offline contact this option closes the current Squirrel Setup File and returns 
Darca to the Main Window.

The Main Window
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Settings Menu
The Settings Menu contains options that configure Darca. Options for changing the 
Squirrel’s settings are found in the Squirrel Menu.

Displays a multi-tabbed dialog box where most of Darca’s settings can be changed. Most 
settings are stored when Darca is closed, including password protection for Squirrel settings.

All communication settings for Darca are displayed in the communications dialog box. 
Settings are stored when Darca is closed. 

If you are using a serial to USB converter, you may wish to use the  utility
to locate the port which has been allocated to the converter. Alternatively, you can use the 

 in Windows to list the COM ports available on your computer. Type 
 in the Windows 7 search box to open this, and look for . USB to 

serial converters are listed as .

Modify transmitter channel assignments and transmitter settings.

A list of descriptions, phone numbers and Squirrel serial numbers can be stored in the phone 
list. The toolbar at the top of the phone list window has buttons to enable entries to be 
added, edited and removed. Clicking on one of the headings will sort the entries by the 
selected column.

Preferences

Communication

Setup Transmitter Channels

Phone List

Settings for the modem can also be changed from 
this window, although any changes in these will not be retained when the program is 
closed. Note: The option  is for Squirrels connected in 
parallel only. It is NOT for Ethernet networking.

RS232 Network Squirrel Settings

Finding the Squirrel’s COM port
COM Port Search  

Device Manager
Device Manager Ports

Prolific USB-to-serial
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Squirrel Menu
The Squirrel Menu only appears when Darca is in contact with a Squirrel. It contains all of 
the options for changing the settings of the Squirrel.

Periodically the Squirrel Status window is updated with the current status of the Squirrel. This 
option forces Darca to update this window immediately and re-open it if it has been closed.

The Squirrel’s current logging state is shown by this menu item. A tick mark next to this 
option indicates that the Squirrel is currently logging. Selecting this option will change the 
logging state by either starting or stopping the Squirrel logging (depending on the current 
state). The logging state  can also be changed from the central control panel of the Contact 
Window.

This option will clear all the readings from the Squirrel’s memory and is not available when 
the Squirrel is logging. The memory can also be cleared from the central control panel of the 
Contact Window.

All of the Squirrel’s settings (with the exception of the channel setup) are controlled from a 
single tabbed dialog box, accessed by selecting this option. If the Squirrel is not reset, there 
will be some settings that cannot be changed. Some settings are not applicable to GenII 
Squirrels.

Refresh Status

Log

Clear Memory

Settings
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View Menu
The items in the View Menu are all for showing non-dialog windows for either displaying 
Squirrel information or changing channel settings. Any or all of the windows opened from 
the View Menu may be open simultaneously. Reselecting an already open window will bring 
that window to the front.

This window is automatically shown when contact is established. It is recommended that 
this window is left open permanently, and moved to a convenient location on the screen. It 
can then be quickly referred to at any time for the current status of the Squirrel. This 
window will be automatically opened to confirm significant changes to the Squirrel settings 
(e.g. whenever the Squirrel is set to start logging).

The Meter Window shows all the current input states of all the currently enabled channels. 
The interval at which it is updated can be changed in the Settings/Preferences dialog box. 
The appearance of the meters can be controlled from the context menu, which is brought 
up by right clicking anywhere on the Meter Window.

To view either Meter and/or Graph go to > >  and select 
the appropriate option from the drop down box. 

Squirrel Status

Meter

Settings  Preferences  Metering
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Channel Setup

Transmitter Status

A spreadsheet style grid shows each Squirrel channel and its corresponding settings. 
Ranges, Wired EU (Engineering Unit) Settings, and Alarms can be reconfigured for 
individual or multiple channels from the Channel Setup Window. A context menu 
(which can be brought up by right clicking on a channel in the Channel Setup 
Window) shows the available options for the currently selected channel(s). Selecting 
Edit Channel brings up a tabbed dialog box from which all of the changes are made.

This feature is for use with Eltek Telemetry Squirrels only. It displays information about 
the transmitters connected to the Squirrel.

The Help Menu contains all of the normal help menu items for the program. A 
comprehensive on-line help system (including a tutorial section) gives all the 
information needed to get the most out of Darca

Help Menu

Note: The Windows Help system is not included with Windows Vista or Windows 7 
by default. Darca Plus uses this form of help. If Windows Help is not installed on your 
PC, see the instructions in the FAQ section of the Eltek website for information on 
how to download it:
http://www.eltekdataloggers.co.uk/faq.shtml#helpsystem
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The Graph Window

The Offline Graph Toolbar

The Graph Window can appear in two forms:
(with Squirrel not connected) to display or graph saved data.
(with Squirrel connected) to display graph and meter (effectively real time) from 

the Squirrel. To graph and/or meter go to  >  and select from 
the drop down menus.

This window allows general graph settings such as colour, gridlines, 3D graphing options 
and plot type to be configured. 

This window provides control over the ranges of the graph axes and the selection of which 
channels are to be plotted on the graph and their assigned colour and axis.

The graph cursor window displays the data values of a point on the graph.

Graph thresholds allow the plotting of threshold limits alongside the channels’ data on the 
graph.

"

"

Offline 
Online 

Preferences Metering

Graph Appearance

Chans / Axes

Cursor

Thresholds
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Summary

Note

Save

Pause

The summary window shows information about the Squirrel from which the data was 
recorded, the data itself, and statistics calculated from the data.

In order to identify meaningful points on the graph, notes may be drawn onto the graph. A 
note consists of a line at the relevant point together with a text label.

The online graph toolbar contains many of the same tools as the offline graph toolbar. 
However, there are two additional ones:

This saves all the data plotted on the online graph into a Squirrel DAT file which may be 
viewed later once contact is finished.

Pauses the flow of data onto the graph and stops it scrolling until pausing is finished, 
whereupon data received during the paused period will be plotted onto the graph.

The Online Graph Toolbar
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GenII / Transmitter Setup 

To access the GenII / Transmitter Setup menu, click  in the main window 
and select the bottom option . The following options are 
then available:

: The 
connected Squirrel’s setup will be loaded into Darca.  Changes to transmitter channels 
and settings can be made. Click on , follow the instructions and 
connect all transmitters in turn before finally clicking on .

: The transmitter 
setup can be modified using a saved Squirrel setup file.

: Update a PC configuration file from the 
current setup of the Squirrel. Use if the Squirrel button panel or another PC was used 
to change settings.

: Update the Squirrel from a current 
configuration stored in the PC.

Note: Squirrel setup files (including transmitter details) are saved as uirrel  nformation files 
(.sqi extension).

Contact Wizard
GenII Setup / Transmitter Setup

Modify the Transmitter setup based on the current Squirrel setup (Normal)

Transmitter Setup  
Send to Squirrel

Modify the transmitter setup based on a Squirrel setup File

Save a Squirrel setup file from a Squirrel

Update the Squirrels setting from a file

"

"

"

"

SQ I

Page 23 of 24

Darca Plus



Automated Contact with a Squirrel

Scheduling Automated Contacts using Shed

Darca’s Automated Contact feature allows you to specify a number of tasks which you 
wish to be performed during a contact with a Squirrel. This is particularly useful if you have 
a number of Squirrels which all require a set series of operations to be performed during 
contact or if you are using a modem to connect to your Squirrel and wish to minimise the 
length of the phone call. Automated Contacts can be scheduled for multiple Squirrels 
using Shed (See below). There are four tasks which may be performed on a Squirrel during 
automated contact: 

Download All Runs (the most recent run is always downloaded)
Clear And Restart
Set up Squirrel
Update Time And Date. 

The  option allows you to configure a wired Squirrel exactly as you require 
using a previously saved wired setup file.

Shed allows you to perform scheduled automated contacts by launching Darca at a 
specified time. It is possible to specify the exact type of automated contact using 
command-line parameters, more details of which can be found in Darca’s online help. You 
may schedule repeated automated contacts with a Squirrel by using the ‘frequency ’ 
setting in Shed.

"

"

"

"

Set up Squirrel
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